• **Action Menu**: The list of actions available at any particular moment, which displays on the left column of every page.

• **Button**: An object that can be clicked to save, complete, or cancel actions taken on the page. Buttons are green with white text throughout the system.

• **Dashboards**
  – **My Cases**: Available to all agency users. It collates all requests, appeals, tasks, referrals, and consultations which are assigned to the currently logged in user.
  – **Unassigned Cases**: The landing page for agency users who are responsible for distributing materials throughout the system. It collates all materials that are assigned to the currently logged in user’s organization.
  – **Assigned Cases**: Available to agency users who are responsible for distributing materials throughout the system. It collates all materials that are assigned to organizations or individuals below the currently logged in user within the organizational hierarchy.

• **Switchboard**: A user who operates as a distributor of items throughout the system.

• **Tab**: Used throughout the system to access new pages. The active tab is white with black text, while inactive tabs are blue with white text.

• **Task**: Used to facilitate access to a request, appeal, or referral for users other than the individual assigned to the request, appeal, or referral.
Roles Defined

Module 2

Learning Objective

• Understand the roles in the system and what they mean to you
• Learn how your organizational chart dictates where you can assign items and where you can’t

Exercises

• None
• Each of you is given at least one role
  1. Some of you are the National Team – the highest role
  2. Some of you are Coordinators for an Echelon – full access across the Echelon
  3. Some of you are Public Liaisons for your office within the Echelon – full access across the office

• Roles give you access to your part of the organizational chart AND below
  – Your office
  – Offices within your office
  – Offices within offices below yours
  – …and so on

• Two factors determine the role you are given
  – Do you act on behalf of the entire agency, an Echelon, or an office?
  – Do you manage work assignments?
### Roles Defined

*Module 2*

<table>
<thead>
<tr>
<th>My job is…</th>
<th>I am typically a…</th>
<th>This allows me to…</th>
</tr>
</thead>
</table>
| **In the National FOIA Office**, receiving requests and routing them across the Agency. | National Team role at the highest level of the organizational chart. | • View and edit any open FOIA request across my agency.  
• Assign any item to anywhere or anyone in the Agency  
• Approve items such as extensions  
• Backdate offline closures  
• Reopen any case across the agency |

| **Within an Echelon**, leading FOIA processing, possibly as a FOIA Officer. | Coordinator role at the Echelon in which I work. | • View and edit any open FOIA request across my Echelon.  
• Assign any item to anywhere or anyone in my office Echelon OR to another Echelon  
• Approve items such as extensions  
• Backdate offline closures |
<table>
<thead>
<tr>
<th>My job is…</th>
<th>I am typically a…</th>
<th>This allows me to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a <strong>Branch or Division</strong> within an Echelon, acting as the FOIA Lead for my office.</td>
<td>Public Liaison</td>
<td>• View and edit any open FOIA request across my Echelon/Division.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign any item to anywhere or anyone in my Echelon/Division OR to another Echelon/Division at my level in the organizational chart</td>
</tr>
<tr>
<td>In a <strong>Branch or Division</strong> within an Echelon, processing FOIA requests that are assigned to me.</td>
<td>Professional -or- SME</td>
<td>• View and edit any open FOIA request that is assigned to me.</td>
</tr>
<tr>
<td>My job is…</td>
<td>I am typically a…</td>
<td>This allows me to…</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| In an **Appeal Processing Unit** such as an OGC, processing Appeals for the Agency. | Public Liaison AND Reviewer | • Get Appeals automatically assigned to my echelon upon creation.  
• View and edit any open Appeals assigned to my echelon.  
• View any FOIA request across the Agency |
Switchboard: A user who operates as a distributor of items throughout the system.

National Team Role  
(Switchboard, WITH Admin rights)

Coordinator Role  
(Switchboard, WITH Admin rights)

Public Liaison Role  
(Switchboard, NO Admin rights)

Each of these offices identifies a small group of people to get one of FOIAonline’s 3 “switchboard” roles to be able to route requests.

- National Team – Oversees all of DON, including administrative functions
- Coordinator – Oversees an office within an Echelon, including administrative functions
- Public Liaison – Oversees an office within an Echelon, with no administrative functions

Who has a Switchboard role in your office? Which role do they have?
• The only roles who can assign requests and task are switchboard roles
  – National Team
  – Coordinators
  – Public Liaisons

• Now, where can these people assign items?
  – Imagine the organizational chart
  – Think of where you sit – where you act on behalf of (i.e. an Echelon, a Branch, an Office, etc.)
  – Use the table at the right to help you

<table>
<thead>
<tr>
<th>Which Offices can I assign to?</th>
<th>Which Individuals can I assign to?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look Left</td>
<td></td>
</tr>
<tr>
<td>Look Right</td>
<td></td>
</tr>
<tr>
<td>Look Up</td>
<td>Look Down</td>
</tr>
<tr>
<td>Look Down</td>
<td>Look Down</td>
</tr>
</tbody>
</table>
• Enter your email address and password into the login fields.

• If your agency is CAC or PIV enabled, then you will not perform this step. Instead, you will be logged in via alternate authentication methods.
Learning Objective

• Review the request workflow
• Understand how the public submits requests
• Learn how to enter different types of requests into FOIAonline

Exercises

• Exercise 4.1 – Creating a FOIA Request
• Exercise 4.2 – Creating a FOIA Request, with Expedited Processing and a Fee Waiver
• Exercise 4.3 – Creating a FOIA Request for a Frequent Requester
• Exercise 4.4 – Creating additional FOIA Requests
Five (5) Step Workflow

- **Submitted**: not yet been viewed by FOIA staff
- **Evaluation**: viewed, but not routed to a person or organization
- **Assignment**: assigned to an individual or organization
- **Processing**: assigned **AND** has had at least one action (estimate costs, upload records, etc.) taken
- **Closed**: completed the Close-Out process

Your actions move a request through the workflow automatically. The workflow status can not be altered manually.
• **Guest**
  - No account necessary
  - Fill out the online form and choose where to direct it within the Agency
  - Able to access their request via the Tracking Number

• **Account**
  - Pre-populates requester name, address, etc.
  - “My Cases” dashboard provides a single view of all their requests and appeals
  - Reply to agency correspondence
  - Able to view records marked for release
• FOIA Staff can enter:
  – New Requests
  – New Consultations
  – New Referrals

• Routing of FOIA Staff submitted requests:
  – New Requests are not routed to you—they go to your Agency’s switchboard
    just like any new request from the public

• Fee Waivers & Expedited Processing
  – Can be entered during or after request creation
Learning Objective

• Understand when to assign to an organization and when to assign to an individual
• Learn the difference between assignments and tasks
• Understand where you can assign items and where you need a manager

Exercises

• Exercise 5.1 – Assign to Me
• Exercise 5.2 – Assign to Individual
• Exercise 5.3 – Assign to Multi-Agency User
• Exercise 5.4 – Assign to Organization
What does it mean to “Make Assignment”?  
- Assigning the Lead on a FOIA response

What are the Assignee’s responsibilities?  
- Determining who else should collaborate by assigning tasks  
- Corresponding with the requester via the Correspondence tab  
- Starting the Close-Out process  
- Setting the Final Disposition

What does it mean to “Create Task”?  
- Asking for help on a FOIA response  
- The action to “Create Task” is only available when a request is perfected  
- Track parallel processing  
- Prohibits Close-Out until all searches for records are complete
The only users able to assign items are switchboard roles.

• Assigning to an Organization
  – Ability to assign to any organization within your agency’s hierarchy
  – **Purpose:** Allow each office to determine who receives assignments

• Assigning to an Individual
  – Limited list: Only people in your organization or “below”
  – **Purpose:** Let the people in an office decide how to allocate requests.
If an individual has multiple actual agencies, you will be prompted to select the agency where the request should be assigned.
• View a request’s assignment history from the Request Details page
Learning Objective

• Become familiar with the FOIAonline look and feel.
• Understand the page layout and navigation.
• Understand the process of assessing a FOIA request.
• Learn how to appropriately set the number of days on the clock.
• Examine how to search for duplicate requests.

Exercises

• Exercise 6.1 – Perfect a FOIA Request
• Exercise 6.2 – Backdate Request Perfection
• Exercise 6.3 – Search for requests by the same requester
Evaluation
Module 6

Request Details

Status: Initial Evaluation  Due Date: 06/24/2014

Tracking Number: EPA-HQ-2014-000226  Submitted Date: 05/11/2014
Requester: Mrs. Mary A. Smith  Perfected Date: 06/11/2014
Organization: N/A  Last Assigned Date: 06/11/2014
Requester Has Account: No  Fee Limit: $25.00

Request Handling

- Requester Info Available to the Public: Yes
- Request Track: Simple
- Fee Category: Select Fee Category
- Fee Waiver Requested: Yes
- Fee Waiver Status: Pending Decision
- Expediting Requested: Yes
- Expediting Status: Pending Decision
- Request Perfected: Yes
- Request Perfected Date: 06/11/2014
- Acknowledgement Sent Date: 06/11/2014
- Unusual Circumstances?: No
- 5 Day Notifications: Yes
- Litigation: No
Perfected Request – a request for records that reasonably describes such records and is made in accordance with published rules stating the time, place, fees (if any) and procedures to be followed.

- When first opened, a user should be able to assess whether or not a request is perfected.
  - Request Perfected defaults to Yes when first accessed, but defaults to No afterwards.
  - A user should also assess the Request Track and Fee Category prior to saving.
Request searches are made on:
- Tracking Number
- Requester
- Organization
- Request Description
Learning Objective

- Understand what information is sent to the requester
- Learn which email addresses are used
- Understand how to add other correspondence to the case file without notifying the requester
- Learn how to view past correspondence sent to requester

Exercises

- Exercise 7.1 – Create Correspondence to the Requester
- Exercise 7.2 – Add Other Correspondence to the Case File
- Exercise 7.3 – Add a Letter to the Case File
• Correspondence can be created at any point in the workflow via the Create Correspondence action in the left-side menu.

• There are two types of Correspondence in a case file:
  – **Correspondence to Requester** – items sent through FOIAonline to the Requester
    • If the requester has a system account, then the requester can reply to correspondence within the system, which automatically updates the case file with the new content.
  – **Other Correspondence** – Items uploaded to maintain a complete case file, which were sent via other methods (e.g., mail, fax)
Correspondence to Requester depends on email address provided

- Email sent from the address listed in the Agency’s administration page (Notification Email Address)
- Email is sent to requester’s address on file AND is saved to the Case File > Correspondence tab
• Other Correspondence is used to upload attachments that were sent outside of FOIAonline
  – Either an Attachment and/or a letter is required
• Insert case-specific information directly into either the email body or letter body via the “Insert” dropdown menu.
  • Ex.: Today’s date, submitted date, request description, etc.

```plaintext
Dear Ben Cooper,

EPA-HQ-2014-000246 submitted on 06/16/2014 is too vague. I need a clear description so that we may perfect your request and begin processing.

Thanks,

FOIA Processor
```
• All correspondence is saved to the Correspondence tab, including system-automated correspondence to the requester (e.g., Submission Confirmation)
  ✓ Case File > Correspondence tab
Learning Objective

- Understand how to upload file(s) to a request.
- Understand the different release types
- Learn how to apply exemptions and how exemptions are counted in the Annual Report.

Exercises

- Exercise 8.1 – Upload Record with File
- Exercise 8.2 – Upload Record without File
- Exercise 8.3 – Apply Exemptions to a Record
• Upload responsive documents via the **Upload Responsive Records** action.
• FOIAonline accepts the uploading of all file types.
Records marked as “releasable” are **only** released after performing either an interim release or final closeout.

The release type can be modified on individual records after upload.

Add keywords to assist in searching and to filter your Case File.

Will **never** be available to the general public:
- UU – Unredacted - Unreleasable
- RU – Redacted - Unreleasable

Available to the general public:
- UR – Unredacted - Releasable to the General Public
- RR – Redacted - Releasable to the General Public

Available to only the **registered requester**:
- REQ – Release to Requester Only
Responsive records are stored in the Case File – Records tab grouped by Release Type (REQ, RR, UR, RU, UU).

- Edit responsive records by clicking the pencil icon (✏️) in the Action column
  - Edit the record title
  - Apply record-specific keywords
  - Apply exemptions
Learning Objective

• Understand the various types of tasks on a FOIA request
• Learn how to use tasks to collaborate with other organizations

Exercises

• Exercise 9.1 – Process a simple task
• Exercise 9.2 – Upload a record in response to a task
• Request Detail Tasks
  – Request must be perfected
  – Able to assign to individuals and organizations

• Other Task Types Generated by FOIAonline
  – Fee Waiver – to adjudicate separate from the request
  – Expedited Processing – to adjudicate separate from the request or appeal
  – Interim Release Review – to notify a reviewer that a request or referral is ready
  – Interim Release Notice – to notify the requester of an interim release
  – Review – to notify a reviewer that a request or referral is ready
  – Final Disposition Notice – to notify the requester of a final disposition
  – Partial Determination Review – to notify a reviewer that an appeal is ready
  – Partial Determination Notice – to notify the requester of a partial determination
• Collaboration Between Components
  – Search
    • Determine participating organizations during initial assignment
    • Create tasks before making the FOIA request assignment
    • **Tasks should be created by highest-level switchboard possible**
  – Review
    • Lead on a FOIA response adds reviewers
    • System generates tasks to each reviewer after disposition is set
Learning Objective
• Understand how to create and process fee waiver tasks.
• Understand how to create and process expedited processing tasks.

Exercises
• Exercise 10.1 – Fee Waiver Processing
• Exercise 10.2 – Expedited Processing
Fee waivers and expedited processing requests are **tasks** associated to the request or appeal.

- Allows for simultaneous processing

Access the task from either the **dashboard** or the **Assigned Tasks tab** of the case file.

Tasks have the same tracking number as the associated case.
• Possible Decisions:
  o Deny
  o Not Billable
  o Full Grant
  o Partial Grant
  o Withdrawn by Requester

• The requester will receive an email of the decision upon task closure.
Processing: Fee Waivers/Exp. Processing

Module 10

- Possible Decisions:
  - Deny
  - Grant
  - Withdrawn by Requester

- The requester will receive an email of the decision upon task closure.
Learning Objective
• Understand the multi-step process
• Learn how to process the estimate and notify the requester
• Understand follow-up actions such as stopping the clock

Exercises
• Exercise 11.1 – Estimate Costs and Send Estimate
• Estimate Costs action in the left-side menu
• Ability to indicate search, review, and copying estimates
• Press Total to calculate the Total Estimate onscreen, which includes fee category deductions
  – If total estimate is in excess of the fee limit, then a notice displays on screen.
• Saving the estimates automatically creates the Estimate Cost Notice task
  • Request status changes to “Estimate Costs”
• Estimate Cost Notice task is accessible from either:
  • the My Cases dashboard of request owner, or
  • Assigned Tasks tab of request
• Send button notifies requester, if email address is on file
• Close Without Sending does not notify requester
• Cost Estimate is saved as correspondence in the case file.
• Mark Estimate as Required? dropdown requires requester to pay estimate before processing occurs
• Stopping the Clock: FOIA staff can stop the clock for fee-related reasons
  • Clock can resume once fees have been paid
Learning Objective

- Understand the necessity of capturing costs within the system
- Be able to input billable and unbillable expenses
- Be able to input expenses for other users

Exercises

- Exercise 12.1 – Create Billable Admin Cost for Self
- Exercise 12.2 – Create Unbillable Admin Cost for Self
- Exercise 12.3 – Create Billable Admin Cost for Other User
- Exercise 12.4 – Create Billable Admin Cost for Non-system User
When first adding an entry, the logged in user’s information populates. Time can be added for another system user by clicking the icon.

- Select the Date, Charge Type, Hours or expense, and whether or not the expense is billable.
- The costs associated to users in the system are calculated automatically along with any discounts applicable to the requester.
• Expenses can also be charged for other system users or non-system users.
• Entering time for non-system users requires their loaded rate and billing rate.
• Agency expenses are calculated using time entered on the Admin Cost tab.
• Administrators can require agency users to enter admin costs before case file close out from the Administration-Configuration tab
• Selections can be cascaded to all sub-agencies using the Update All for Designated Case Files? checkbox
Learning Objective

• Learn how and when reviews occur
• Understand rules on adding/removing reviewers
• Understand agency choices on minimum reviews
• Learn how reviewers are notified

Exercises

• Exercise 13.1 – Add Reviewers
Multiple reviewers can be assigned and reordered via the **Review tab**.

Reviews automatically start once the interim release or final close out processes begin.

- Second step of the record release processes
- After a disposition is set
- Task Type: Review
- Linear, in order shown on a FOIA Request

**Notifications**

- Reviewers aren’t notified until there is a disposition set to review
- Task appears in their MY CASES dashboard
• Rules
  – Only the person who adds a reviewer to a case file can remove that reviewer
  – Anyone with edit access can add a reviewer and reorder
  – Reviewers cannot be modified once the interim release or close out process begins

• Agency Choices
  – Agency minimums are defined when an Agency joins FOIAonline, but can be modified later on the Agency Administration – Configuration tab
  – Requests and Appeals cannot be closed unless they meet the prescribed agency minimum
Learning Objective

• Understand the 3-Step Close Out process
• Learn the rules for using each disposition
• Best practices for using the “other, other” disposition

Exercises

• Exercise 14.1 - Close Out with Records Released
• Exercise 14.2 - Close Out with Exemptions Applied
• Step 1: Set the Disposition
  – Use the Begin Close-Out action item
  – Select the final disposition
  – Review which records will be published
  – Review which exemptions are applied
  – Enter any invoice instructions
  – Start the case file review chain

• Step 2: Conduct Case File Review
  – Reviewers listed on review tab get tasks and approve/reject

• Step 3: Send Disposition Notice
  – Request owner gets a task and system email notification
  – Close-out task notifies the requester (Final Disposition Notice task)
• Rules
  – An individual must be assigned to the request
  – All tasks must be closed
  – Full Grant cannot be used if you have exemptions
  – Full Denial based on exemptions cannot be used if you do not have exemptions
• If the required disposition is not listed within the standard set of dispositions, then Administrators can add new dispositions for requests and appeals from the Administration-Configuration tab.
  – These values are summarized on the Annual Report
  – These values should not duplicate an existing disposition (i.e. Full Grant)
  – These values can be made Active or Inactive
  – The disposition is saved to the request’s Case File, Case Details section.

• Examples
  – Example of an appropriate value: GLOMAR
  – Examples of inappropriate values: Grant, Records Released
Step 2: Conduct Case File Review

- Reviewers listed on review tab get tasks and approve/reject

- Approved: If multiple reviewers were listed in the Review tab, then the next reviewer in the queue receives his/her case file review task
  - Final Disposition Notice task gets sent to the FOIA Lead

- Rejected: Request processing restrictions are lifted and the FOIA Lead makes any edits and begins the close out process again.

- Note: There is NO “conditional approval”! Reject the task, even if the smallest error needs to be fixed.
• Step 3: Send Disposition Notice
  – The request owner receives a notification that the **Final Disposition Notice task** exists in their MY CASES dashboard, upon the last reviewer’s approval of the Final Review task.
  – Modify the subject and body of the email sent to the requester
  – Request owner can select from previously uploaded records, invoices, or past correspondence to send as email attachments.

• Only records marked as Releasable or REQ are available for selection to attach to this email to the requester

• Once the task is closed, all records marked as “releasable to the general public” will be available to the general public via FOIAonline.
If an individual has multiple actual agencies, you will be prompted to select the agency where the request should be captured upon close-out.
Learning Objective

• Learn how to Stop and Start the Clock

Exercises

• Exercise 15.1 – Stop the Clock
• Exercise 15.2 – Start the Clock
Modifying the clock:
- To stop the clock, select from one of two reasons for stoppage: clarification or fee-related. Note that clarification can only be used once.
- Stopping the clock allows the request due date to be extended without approval.
- Clock start and stop dates **CANNOT** be backdated.
Due Date Management

Module 16

Learning Objective
• Learn how to Extend the Due Date on requests and tasks

Exercises
• Exercise 16.1 – Extend Request Due Date
• Exercise 16.2 – Extend Task Due Date
Extending Request Due Dates:

- Select the Extend Due Date action item from the left-side menu.
- If a clock stoppage previously existed, then the due date can be extended without approval.
- Enter required fields and click Extend Due Date.

![Extend Due Date interface]

Due Date Management
Module 16

3/31/2016
Extending Task Due Dates:

- Only available to users who have edit access to the request
- All pending task due dates are editable from the Assigned Tasks tab.
Learning Objective

• Understand how to perform an Interim Release of a subset of records while the request itself is still being processed

Exercises

• Exercise 17.1 – Interim Release
Interim Release:

- Requires at least 3 levels of review
- Requires the release of at least 1 record
- Record is released upon Interim Release Notification task closure
Learning Objective

• Learn how to create Referrals and Consultations

Exercises

• Exercise 18.1 – Referral Creation
• Exercise 18.2 – Consultation Creation and Closure
To create Referrals and Consultations, a request must: 1. be perfected and 2. uploaded records must exist.

**Referral** – An action performed on an individual record when an agency finds a record in the course of searching, which originated at another agency.

- Select the Create Referral action item from the Request Details page
- Select the Agency for referral
- Select the responsive records to include within the referral by clicking the checkbox in the Include in Referral column of the Responsive Records section
  - The record(s) sent will be no longer available to the original agency
Referrals and Consultations

Module 18

• Referral Confirmation screen will display upon clicking Submit

![Referral Confirmation Screen]

• Referred agency will receive the referral in their Unassigned Cases Dashboard
• Agency referred shall process the referral as they would a regular request
• Original agency assigned shall continue processing the request to close out
Consultation - The procedure whereby the agency responding to a FOIA request first forwards a record to another agency for its review because that other agency has an interest in the document. Once the agency in receipt of the consultation finishes its review of the record, it responds back to the agency that forwarded it. That agency, in turn, will then respond to the FOIA requester.

- Select the Create Consultation action item from the Request Details page
- Select Responsive Records to send for Consultation and click Next

![Select Responsive Records for Consultation](image-url)

![Next and Cancel buttons](image-url)
Referrals and Consultations

Module 18

• Select the Agency you would like to have consult the record
  ✓ Enter required fields and click Create Consultation
• Consultation Confirmation will display and the case will appear in the consulted agency’s Unassigned Cases dashboard.
• Select Back to Request Detail button to go back to the Request Details page
Learning Objective
• Learn how to Log Payments

Exercises
• Exercise 19.1 – Logging Payments
Logging payments:
• Agency users are able to enter Manual payments made by the requester in the Payments section of the Financing tab
  • Click the Add Payment button and enter the following required fields:
    ✓ Amount Paid
    ✓ Payment Date
• Press Save Changes to log payment
• Delinquent requesters display in the Delinquency Report
Module 1 - Terms & Acronyms

This module provides a list of system terms and definitions, which may be useful in understanding training topics and terminology within the exercises.

Terms & Acronyms Training Details

The following pages contain a mixture of FOIA and system related terms, which will be used throughout the training and within the FOIAonline system. Refer to this module if you are unsure of terminology presented in the context of FOIAonline.
**Action** - An individual piece of functionality, which, when clicked, takes the user to a targeted page.

**Action Menu** - The list of actions available at any particular moment; it displays on the left column of every page.

**Administrative Appeal** - A request to a federal agency asking that it review the request at a higher administrative level, a FOIA determination made by the agency at the initial request level.

**Assigned Cases** - The Assigned Cases dashboard is available to agency users who are responsible for distributing materials throughout the system, and is only available to those users. It collates all requests, appeals, tasks, referrals, and consultations, which are assigned to organizations or individuals below the currently logged in user within the organizational hierarchy. The Assigned Cases display can be altered using the Filter dropdown to display a subset of the cases assigned to other users.

**Audit Log** - A record of all of the actions taken on a case file.

**Backlog** - The number of requests or administrative appeals that are pending at an agency at the end of the fiscal year that are beyond the statutory time period for a response.

**Button** - An object that can be clicked to save, complete, or cancel actions taken on the page. Buttons are green with white text throughout the system.

**Close Out** - A FOIA request has been either completed or cancelled. Nothing more can be added or changed in the case file.

**Component** - For agencies that process requests on a decentralized basis, a “component” is an entity, also sometimes referred to as an Office, Division, Bureau, Center, or Directorate, within the agency that processes FOIA requests. The FOIA now requires that agencies include in their Annual FOIA Report data for both the agency overall and for each principal component of the agency.

**Consultation** - The procedure whereby the agency responding to a FOIA request first forwards a record to another agency for its review because that other agency has an interest in the document. Once the agency in receipt of the consultation finishes its review of the record, it responds back to the agency that forwarded it. That agency, in turn, will then respond to the FOIA requester.

**Dashboard** - The landing page for all agency users. There are 3 dashboards in FOIAonline: My Cases, Unassigned Cases, and Assigned Cases. Depending on a user’s role they may see all three dashboards or only My Cases. The dashboards appear at the top of the Action Menu at the left of the page.

**Disposition Code** - The final determination made on requests and appeals.

A. For requests, the disposition codes are:
   i. Full grant
ii. Partial grant/partial denial
iii. Full denial based on exemptions
iv. No record
v. All records referred to another component or agency
vi. Request withdrawn
vii. Fee-related reason
viii. Records not reasonably described
ix. Improper FOIA for other reason
x. Not an agency record
xi. Duplicate request
xii. Other

B. For appeals, the disposition codes are:
   i. Completely Affirmed
   ii. Partially Affirmed and Partially Reversed/Remanded
   iii. Completely Reversed/Remanded
   iv. No records
   v. Records referred at initial request level
   vi. Request withdrawn
   vii. Fee-related reason
   viii. Records not reasonably described
   ix. Improper requests for other reasons
   x. Not an agency record
   xi. Duplicate request or appeal
   xii. Request in litigation
   xiii. Appeal based solely on denial of request for expedited processing
   xiv. Other

Employee -

A. “Full-time FOIA Employee” - A full-time employee who performs FOIA duties 100% of the time.

B. “Equivalent Full-Time FOIA Employee” - Created by adding together the percentages of time dedicated to FOIA duties by employees performing less than full-time FOIA duties. Each time 100% is reached, the time expended is counted as one “equivalent full-time FOIA employee.”

Exclusions - In three carefully defined situations, certain sensitive law enforcement records are “excluded” from the requirements of the FOIA.

A. (c)(1) Exclusion: Subject of a criminal investigation or proceeding is unaware of the existence of records concerning the pending investigation or proceeding and disclosure of such records would interfere with the investigation or proceeding.

B. (c)(2) Exclusion: Informant records maintained by a criminal law enforcement agency and the individual's status as an informant is not known.

C. (c)(3) Exclusion: Existence of FBI foreign intelligence, counterintelligence or international terrorism records are classified fact.

Exemption Codes - There are nine FOIA exemptions that can cause a request to be fully denied.
A. **Exemption 1**: classified national defense and foreign relations information
B. **Exemption 2**: internal agency rules and practices
C. **Exemption 3**: information that is prohibited from disclosure by another federal law
D. **Exemption 4**: trade secrets and other confidential business information
E. **Exemption 5**: inter-agency or intra-agency communications that are protected by legal privileges
F. **Exemption 6**: information involving matters of personal privacy
G. **Exemption 7**: records or information compiled for law enforcement purposes, to the extent that the production of those records (A) could reasonably be expected to interfere with enforcement proceedings, (B) would deprive a person of a right to a fair trial or an impartial adjudication, (C) could reasonably be expected to constitute an unwarranted invasion of personal privacy, (D) could reasonably be expected to disclose the identity of a confidential source, (E) would disclose techniques and procedures for law enforcement investigations or prosecutions, or would disclose guidelines for law enforcement investigations or prosecutions, or (F) could reasonably be expected to endanger the life or physical safety of any individual
H. **Exemption 8**: information relating to the supervision of financial institutions
I. **Exemption 9**: geological information on wells

**Fees** - There is no fee to file a FOIA request and no fees are charged for processing. The FOIA divides requesters into four fee categories:

A. *Commercial requesters* (see, *Requester*) may be charged fees for searching for records, reviewing the records, and photocopying them.
B. *Educational or noncommercial scientific institutions* (see, *Requester*) are charged for photocopying, after the first 100 pages.
C. *Representatives of the news media* (see, *Requester*) are charged for photocopying after the first 100 pages.
D. *All other requesters* (see, *Requester*) are charged for photocopying after 100 pages and for time spent searching for records in excess of two hours. EPA charges $0.15 per page for single-sided black and white photocopying. Actual costs are charged for a format other than paper copy, such as computer tapes, disks and videotapes.

**FOIA** - Freedom of Information Act.
**FOIA Control Number** - The number that is created in Documentum upon closing the case file.

**Full Denial** - An agency decision not to release any records in response to a FOIA request because the records are exempt in their entireties under one or more of the FOIA exemptions, or because of a procedural reason, such as when no records could be located. (See, *Exemptions*).

**Full Grant** - An agency decision to disclose all records in full in response to a FOIA request.

**Interim Releases** - Also a “rolling release.” Large files or requests can be issued in sections.

**Marimba-distributable client** - Reduces the complexity and costs of managing desktops, laptops, and handheld devices through policy-based automation of application management, operating system migration, patch management, inventory, and software usage tracking.

**Master Request** - A navigable, cross-referenced, and searchable framework that contains all relevant and associated information of a request.

**Metadata Review** - Upon record(s) being release to the requester and/or a disposition being marked on the request, the case file is sent to the National Team for a final review of all of the file’s metadata before the request is officially closed out in the system.

**Multi-Track Processing** - A system in which simple requests requiring relatively minimal review are placed in one processing track and more voluminous and complex requests are placed in one or more other tracks. Requests granted expedited processing are placed in yet another track. Requests in each track are processed on a first in/first out basis.

A. **Expedited Processing** - Are to be completed within 10 calendar days of receipt of the request. To be expedited, the request must satisfy one of two conditions: 1) There is a threat to someone’s life or physical safety or 2) The requestor is someone in charge of disseminating information and there is a need to inform the public about actual or alleged government activity.

B. **Simple Request** - A FOIA request that an agency using multi-track processing places in its fastest (non-expedited) track based on the low volume and/or simplicity of the records requested.

C. **Complex Request** - A FOIA request that an agency using multi-track processing places in a slower track based on the high volume and/or complexity of the records requested.

**My Cases** - The My Cases dashboard is available to all agency users. It collates all requests, appeals, tasks, referrals, and consultations that are assigned to the currently logged in user. The My Cases display can be altered using the Filter dropdown to display a subset of the cases assigned to a user.

**OIP** - Office of Information and Privacy

**Partial Grant/Partial Denial** - In response to a FOIA request, it is an agency decision to disclose portions of the records and to withhold other portions that are exempt under the FOIA, or to otherwise deny a portion of the request for a procedural reason.
Pending Request or Pending Administrative Appeal - A request or administrative appeal for which an agency has not taken final action in all respects.

Perfected Request - A request for records that reasonably describes such records and is made in accordance with published rules stating the time, place, fees (if any), and procedures to be followed.

Processed Request or Processed Administrative Appeal - A request or administrative appeal for which an agency has taken final action in all respects.

Referral - An action performed on an individual record when an agency finds a record, in the course of searching, that originated at another agency.

Responsive Records - “Any information that would be an agency record... when maintained by an agency in any format.” Documents, audio, video, and software programs can all be considered records.

Retention - The amount of time the agency is required to hold the record prior to destruction.

Requester - Any individual[s] (not restricted to American citizens), partnership[s], corporations[s], association[s], or public or private organization[s] other than an agency who submits a request for records from a federal agency.

A. Commercial Requester - Commercial use request means a request from or on behalf of one who requests information for a use or purpose that furthers the commercial, trade, or profit interest of the requester or the person on whose behalf the request is made.

B. Educational or Noncommercial Scientific Institution Requester - Educational institution means a preschool, a public or private elementary or secondary school, an institution of undergraduate or graduate higher education, an institution of professional education, or an institution of vocational education that operates a program or programs of scholarly research. Non-commercial scientific institution means an institution that is not operated on a “commercial” basis and that is operated solely for the purpose of conducting scientific research, the results of which are not intended to promote any particular product or industry.

C. News Media Representative Requester - Representative of the news media means any person actively gathering news for an entity that is organized and operated to publish or broadcast news to the public. The term “news” means information that is about current events or that would be of current interest to the public. News media include television or radio stations broadcasting to the public at large and publishers of periodicals (but only in those instances when they can qualify as disseminators of “news”) who make their products available for purchase by the general public.

D. Other - An individual seeking records for personal use and not for commercial use.

Request Type - A request received through FOIAonline can be considered a: Request, Consultation, Referral, or Appeal.
Section 508 of the Rehabilitation Act - Requires Federal agencies to make their electronic and information technology accessible to people with disabilities.

“Stop the clock” - Suspend a case so that time does not accrue.

Tab - Tabs are used throughout the system to access new pages. Tabs are presented in a variety of locations within the system but always display in a row. The active tab is white with black text, while inactive tabs are blue with white text.

Task - Tasks are used to facilitate access to a request, appeal, or referral for users other than the individual assigned to the request, appeal, or referral. When a task is generated the task recipient can perform actions on a request in parallel with the request owner. Prior to closing out a request all tasks must be closed.

Time Limits - The time period in the statute for an agency to respond to a FOIA request (ordinarily twenty working days from receipt of a perfected FOIA request and ten working days for an expedited FOIA request).

Transfer Request - Moving a request from the agency that received it to the agency it should have been submitted.

Unassigned Cases - The Unassigned Cases dashboard is the landing page for agency users who are responsible for distributing materials throughout the system, and is only available to those users. It collates all requests, appeals, tasks, referrals, and consultations that are assigned to the currently logged in user’s organization. The Unassigned Cases display can be altered using the Filter dropdown to display a subset of the cases assigned to the organization.

User - The officer or analyst in charge of handling and processing requests or appeals.
Module 2 - Roles Defined

FOIAonline uses roles to provide the right permissions at the right time. Further, FOIAonline uses roles to allow flexibility from office to office with the processing of FOIA requests.

Roles Defined Training Details

- Overview of FOIAonline Roles and Why they Exist
  - Role Names
  - Permissions Granted by Each Role
- Typical Roles in an Organization
Module 3 - Login and Navigation

FOIAonline login done through PIV authentication. Once logged in, navigation is centered around tabs across the top of the screen, action items down the left side, and sub-tabs toward the bottom of many pages.

The public has its own view of FOIA requests in FOIAonline, with far less information available.

Login Training Details

- Logging In & Out
- FOIAonline for the Public
- Menus, Buttons & Tabs

Don’t process FOIA items in multiple browser tabs! Keep only one FOIAonline window open at any time to limit confusion and risk of system errors.
Submission is the first step in the FOIAonline workflow. Submitted requests have not yet been evaluated for perfection and have not yet been routed within an agency.

Module 4 – Submission

Submission Training Details

- Review of the Request Workflow
- Public Request Submission
- FOIA Staff Data Entry

FOIAonline encourages submission directly by the requester themselves to save the FOIA staff time and effort performing data entry. When that isn’t possible, FOIA staff use the New Request process to capture information about the request which has been received.
Exercise 4.1: Creating a FOIA Request

Agency FOIA staff use this exercise to enter FOIA requests into FOIAonline if they were not received in FOIAonline (such as fax, mail, email, etc.)

1. Go to HOME tab.
2. Press the NEW REQUEST action item in the left-side menu.
3. Enter the following Agency Information.
   a. Agency: Ask the Instructor
   b. Sub-Agency: Ask the Instructor
   c. Submitted Date: Today’s Date
4. Enter the following Contact Information
   a. First Name: Enter Your First Name
   b. Last Name: Enter Your Last Name
   c. Email Address: Enter Your Email Address
   d. Mailing Address Location: United States/U.S. Territories
   e. Address Line 1: Enter an Address
   f. City: Enter Your City
   g. State/Province: DC
   h. Zip Code/Postal Code: 20064
5. Enter the following Processing Fees Information
   a. Will Pay Up To: $25.00
6. Enter the Description, up to 2,000 characters
   a. Dear (Enter First and Last Name), I am seeking records from the beginning of this FY through today, (Enter the current date and time) under the FOIA regarding correspondence between Senator Smith and the National FOIA Officer.
7. Choose NO in the Request a Fee Waiver Section
8. Choose NO in the Request Expedited Processing Section
9. Press the PREVIEW button and review what you have entered
10. Press the SUBMIT button at the bottom of the screen
11. Write down the tracking number: ______________________

Repeat this exercise as time allows, writing down the tracking number for each request you create. These can be used for processing in later portions of this course.
Exercise 4.2: Creating a FOIA Request, with Expedited Processing and Fee Waiver Requested

Agency FOIA staff use this exercise to enter FOIA requests into FOIAonline if they were not received in FOIAonline (such as fax, mail, email, etc.). In this exercise, they also capture the requester’s desire to have a fee waiver issued and have expedited processing performed.

1. Go to HOME tab.
2. Press the NEW REQUEST action item in the left-side menu.
3. Enter the following Agency and Fee Information:
   a. Agency: Ask the Instructor
   b. Sub-Agency: Ask the Instructor
   c. Submitted Date: Today’s Date
4. Enter the following Contact Information:
   a. First Name: Enter Your First Name
   b. Last Name: Enter Your Last Name
   c. Mailing Address Location: United States/U.S. Territories
   d. Address Line 1: Enter an Address
   e. City: Enter Your City
   f. State/Province: DC
   g. Zip Code/Postal Code: 20064
5. Enter the following Processing Fee Information:
   a. Will Pay Up To: $25.00
6. Enter the Description, up to 2,000 characters:
   a. Dear (Enter First and Last Name), I am seeking records from the beginning of this FY through today, (Enter the current date and time) under the FOIA regarding correspondence between Senator Smith and the National FOIA Officer.
7. Choose YES in the Request a Fee Waiver Section.
   a. Enter: The disclosure of the information sought is in the public interest since it will be used in a published report that is likely to contribute significantly to the public’s understanding of and awareness of the operations and activities of the government. As a non-profit organization, we have no commercial interest in the disclosure.
   b. Enter the Fee Waiver Submitted Date: Enter Today’s Date
8. Choose YES in the Request Expedited Processing Section.
   a. Enter: This FOIA request meets the standard of “urgently
      needed to inform the public.”
   b. Enter the Expedited Submitted Date: Enter Today’s Date

9. Press the PREVIEW button and review what you have entered

10. Press the SUBMIT button at the bottom of the screen

11. Write down the tracking number: __________________________

Repeat this exercise as time allows, writing down the tracking number
for each request you create. These can be used for processing in later
portions of this course.
Exercise 4.3: Creating a FOIA Request for a Frequent Requester

Agency FOIA staff use this exercise to enter FOIA requests into FOIAonline if they were not received in FOIAonline (such as fax, mail, email, etc.) For frequent requesters, their contact information can be pre-populated on the Create Request form.

1. Go to UNASSIGNED CASES.
2. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
3. Click on the icon next to the requester’s name.
4. Enter the following Agency and Fee Information:
   a. Agency: Ask the Instructor
   b. Sub-Agency: Ask the Instructor
   c. Submitted Date: Choose a Date
   d. Perfected Date: Choose a Date
5. Modify the pre-populated Contact Information section as desired.
6. Enter the following Processing Fee Information:
   a. Will Pay Up To: $25.00
7. Enter the Description, up to 2,000 characters:
   a. Enter any request description that you wish.
8. Choose NO in the Request a Fee Waiver Section
9. Choose NO in the Request Expedited Processing Section
10. Press the PREVIEW button and review what you have entered
11. Press the SUBMIT button at the bottom of the screen
12. Write down the tracking number: __________________________
Exercise 4.4: Creating additional FOIA Requests

Agency FOIA staff use this exercise to enter FOIA requests into FOIAonline if they were not received in FOIAonline (such as fax, mail, email, etc.)

1. Go to HOME tab.
2. Press the NEW REQUEST action item in the left-side menu.
3. Enter the following Agency and Fee Information:
   a. Agency: Ask the Instructor
   b. Sub-Agency: Ask the Instructor
   c. Submitted Date: Choose a Date
   d. Perfected Date: Choose a Date
4. Enter the following Contact Information:
   a. First Name: Enter Your First Name
   b. Last Name: Enter Your Last Name
   c. Mailing Address Location: United States/U.S. Territories
   d. Address Line 1: Enter an Address
   e. City: Enter Your City
   f. State/Province: DC
   g. Zip Code/Postal Code: 20064
5. Enter the following Processing Fee Information:
   a. Will Pay Up To: $25.00
6. Enter the Description, up to 2,000 characters:
   a. Enter any request description that you wish.
7. Choose NO in the Request a Fee Waiver Section
8. Choose NO in the Request Expedited Processing Section
9. Press the PREVIEW button and review what you have entered
10. Press the SUBMIT button at the bottom of the screen
11. Write down the tracking number: __________________________

Repeat this exercise as time allows, writing down the tracking number for each request you create. These can be used for processing in later portions of this course.
Module 5 - Assignment

The assignment process, which takes place after submission and evaluation have completed, allows flexible routing within an organization to offices or individuals. An unassigned request is one that has only been assigned to an office, not an individual.

Assignment Training Details

- Choosing the right type of assignment: individual or organization
- Distinguishing between assignments and tasks
- Understanding your assignment permissions

Assignments represent who is taking the Lead on a FOIA response. Each FOIA request can have one assignment. Alternately, Tasks represent collaboration on a response. Each FOIA request can have multiple tasks.
Exercise 5.1: Assign to Me

“Assign to Me” transfers ownership of a request. It can be used to assign a request for the first time or to take over responsibilities from another staff member who is on leave.

1. Go to UNASSIGNED CASES
2. Choose one of the FOIA Requests that you created in Exercises 4.1 through 4.4 (use the tracking number that you wrote down)
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details
5. Press the button that says MAKE ASSIGNMENT in the set of action buttons on the left-hand side of the screen
6. A new section, called Make Assignment, appears within the Request Details. Click on the ASSIGN TO ME button.
7. The FOIA request has been successfully assigned. Click the link at the top of the page to return to the request.

Once assigned to you, this request is best accessed from MY CASES.
Exercise 5.2: Assign to Individual

All FOIA requests should be assigned to an individual for processing. For some requests, FOIA staff may make an assignment to an office, which may then make an assignment to a branch or division, and so on.

Once a FOIA request has been assigned to the correct office, someone in that office should then assign the FOIA request to the individual who is responsible for taking the lead on its response.

1. Go to UNASSIGNED CASES.
2. Choose one of the FOIA Requests that you created in Exercises 4.1 through 4.4 (use the tracking number that you wrote down).
3. Copy that tracking number here: _________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says MAKE ASSIGNMENT in the set of action buttons on the left-hand side of the screen.
6. A new section, called Make Assignment, appears within the Request Details. Click on the INDIVIDUAL ASSIGNMENT icon ( ).
7. A new window opens, titled SELECT INDIVIDUAL.
8. Enter the name of an individual within your office in the NAME field.
9. Press the SEARCH button.
10. Look at the search results shown and select one of the individuals within your Office.
11. Press the SELECT button to save your selection.
12. Note the individual’s name in the INDIVIDUAL ASSIGNMENT section.
13. Press the SAVE CHANGES button to finalize this assignment.
14. The FOIA request has been successfully assigned. Click the link at the top of the page to return to the request.

Checklist for Success in Assigning FOIA Requests:

✓ Am I assigning to someone in my office or below my office?
✓ Do I have access to the Assigned and Unassigned Cases dashboards?

When you need to assign a FOIA request to someone in another office, you may need to contact your manager or someone who has access to the Assigned Cases dashboard and can see that request.
Exercise 5.3: Assign to Multi-Agency User

An individual may be assigned to multiple actual agencies. When assigning a request to such an individual, you will need to select which office you would like the case to be assigned under.

1. Go to UNASSIGNED CASES.
2. Choose one of the FOIA Requests that you created in Exercises 4.1 through 4.4 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says MAKE ASSIGNMENT in the set of action buttons on the left-hand side of the screen.
6. A new section, called Make Assignment, appears within the Request Details. Click on the INDIVIDUAL ASSIGNMENT icon ( ).
7. A new window opens, titled SELECT INDIVIDUAL.
8. Enter the name of an individual within your office that is assigned to multiple actual agencies in the NAME field.
9. Press the SEARCH button.
10. Look at the search results shown and select one of the individuals within your Office.
11. Press the SELECT button to save your selection.
12. A new window opens, titled SELECT ORGANIZATION.
13. Select one of the available actual agencies using the radio button.
14. Press the SELECT button to save your selection.
15. Note the individual's name in the INDIVIDUAL ASSIGNMENT section.
16. Note the actual agency in the ACTUAL AGENCY ASSIGNMENT section.
17. Press the SAVE CHANGES button to finalize this assignment.
18. The FOIA request has been successfully assigned. Click the link at the top of the page to return to the request.
Exercise 5.4: Assign to an Organization

Assigning to an organization gives each office the ability to handle FOIA requests in the best manner that correlates to office policy and procedure. FOIA requests get assigned to offices so that the office staff can determine who best to handle that request. Furthermore, it prevents others around an agency from having to maintain a current list of individuals receiving FOIA requests in each office.

1. Go to UNASSIGNED CASES.
2. Choose one of the FOIA Requests that you created in Exercises 4.1 through 4.3 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says MAKE ASSIGNMENT in the set of action buttons on the left-hand side of the screen.
6. A new section, called Make Assignment, appears within the Request Details. Click on the ORGANIZATION ASSIGNMENT icon ( 📊 ).
7. A new window opens, titled SELECT ORGANIZATION.
8. Note that the search results contain names of offices that are part of your office (below).
9. Enter the name of an office within your agency in the NAME field.
10. Press the SEARCH button.
11. Look at the search results shown and select one of the other offices available to you.
12. Press the SELECT button to save your selection.
13. Note the office’s name in the ORGANIZATION ASSIGNMENT section.
14. Press the SAVE CHANGES button to finalize this assignment.
15. The FOIA request has been successfully assigned. Click the link at the top of the page to return to the request.

Once assigned to an office, anyone with access to the Unassigned and Assigned Cases dashboards for that office will be able to view, assign, and process that request.

The list of organizations offices available for assignment is limited to:

a) offices that are below yours, and

b) offices that are at the same level in the organization chart as yours.

This control seeks to prevent someone from “kicking back” a request to the office that sent it to them. Offices which made an improper assignment should retrieve the request and “take it back”.

Once assigned to an office, anyone with access to the Unassigned and Assigned Cases dashboards for that office will be able to view, assign, and process that request.
Module 6 - Evaluating a Request

Evaluating a request is the process by which a user determines whether or not the request, as submitted, is capable of being processed by the agency.

The Request Details page is the anchor for all functionality within FOIAonline. From the Request Details page, a user is capable of accessing all functionality available on the request and determining if there are tasks, appeals, consultations, or referrals associated to the request.

Evaluation Training Details

In this module the user will learn how to indicate a request can be processed and set the appropriate request track and fee category. Designating the perfection date is not required to close out a request, but can only be set once on a request. Once a request is perfected it allows the user to create tasks, upload responsive records, apply exemptions, and create consultations and referrals.

The Request Details page has the status, due date, and clock at the top right of the page. Below that information is the phase diagram with a highlighted node indicating the current phase. Next, is the expandable request information section. This section displays the request tracking number and basic requester information, but can be expanded to display additional requester provided information in addition to important assignment history information. If the requester does not have an account then the information they provided can be modified by clicking the pencil icon - requesters with accounts must modify their own information.

Following the requester information are the Request Details tabs. The tabs are: Submission Details, Case File, Admin Cost, Assigned Tasks, Comments, and Review. These tabs will be described in further detail in the following modules but provide the backbone for request processing.
Exercise 6.1: Perfecting a Simple Request on First Access

Much of the request processing functionality is restricted to perfected requests. Once a request is perfected, new actions become available in the left side menu.

1. Access the appropriate request by clicking the Tracking Number from the dashboard or search results.
2. (Optional) Modify the Requester Info Available to the Public dropdown as necessary - this dropdown is initially set to the agency configurable value.
3. (Optional) Modify the Request Track as necessary. This selection can be changed throughout processing of the request.
4. (Optional) Modify the Fee Category as necessary. The Fee Category selection automatically applies discounts to the invoice. This selection can be changed throughout processing of the request.
5. Verify the description entered in the free text field within the Request Description section is satisfactory to locate the records requested.
6. Ensure the Request Perfected dropdown says “Yes”.
7. (Optional) Enter text in the Short Description field. This text displays upon hover over in the user dashboard.
8. Press the SAVE CHANGES button.

Note: Upon first accessing a request, the Request Perfected dropdown defaults to Yes. If the selection is not saved, the Request Perfected dropdown defaults to No every subsequent time the request is opened.
Exercise 6.2: Backdate Request Perfection

Much of the request processing functionality is restricted to perfected requests. Once a request is perfected new actions become available in the left side menu.

1. Access the appropriate request by clicking the Tracking Number from the dashboard or search results. *Note: The request must have been submitted prior to the current date.

2. (Optional) Modify the Requester Info Available to the Public dropdown as necessary - this dropdown is initially set to the agency configurable value.

3. (Optional) Modify the Request Track as necessary. This selection can be changed throughout processing of the request.

4. (Optional) Modify the Fee Category as necessary. The Fee Category selection automatically applies discounts to the invoice. This selection can be changed throughout processing of the request.

5. Verify the description entered in the free text field within the Request Description section is satisfactory to locate the records requested.

6. Ensure the Request Perfected dropdown says “Yes”.

7. Click the Perfected Date field or calendar (📅) icon.

8. Enter a date prior to the current date, but after the request submitted date - the date the request was perfected.

9. Press the SAVE CHANGES button.
Exercise 6.3: Search for Requests by the Same Requester

In order to verify there have not been duplicate requests created for other levels of an agency, an agency user is able to search on the requester’s name.

1. Click the REPORTS tab at the top of the page.
2. Click the CUSTOM REPORT action in the left side menu.
3. In the “Requester Name” field, enter the requester’s full name.
4. (Optional) Modify other selections to refine the types of items you wish to return. Ex. Only requests, only open items, etc.
5. Press the SEARCH button.
Module 7 - Processing: Correspondence

Agency FOIA staff can use FOIAonline to author correspondence and send it to a requester’s email address, if they have provided one. Alternately, FOIA staff can upload correspondence sent by other means (for example, mail) in order to maintain a more accurate and complete online case file.

Correspondence Training Details

- Controlling what goes to the requester
  - Correspondence to Requester
    - When an email address is provided
    - When an email address is not provided
  - Other Correspondence
  - PDF Letters
- Understanding Email Addresses
Exercise 7.1 – Create Correspondence to the Requester

In this exercise, students will author correspondence and allow that correspondence to be sent to the requester.

1. Go to MY CASES
2. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down)
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details
5. Press the button that says CREATE CORRESPONDENCE in the set of action buttons on the left-hand side of the screen
6. A new section, called Create Correspondence, appears within the Request Details.
7. Enter the following for the fields:
   a. Correspondence Type: Correspondence to Requester
   b. Subject: FOIA Request Clarification
   c. Body: Please clarify the above-referenced request, providing a date range.
      i. Use the “Insert” dropdown menu, as necessary, to place case file-specific information into the text area.
8. Note the following pre-populated fields:
   a. From: The notification email address configured for your agency.
   b. To: The requester’s email address.
9. Press the CREATE button
10. The correspondence has been successfully added to the Case File and an email has been sent to the requester.

After this exercise, you should see a new correspondence item in the case file under the correspondence tab.
Exercise 7.2 – Add Other Correspondence to the Case File

_In this exercise, students will add correspondence to the case file without notifying the requester, to account for communications that have occurred outside of the FOI online system._

1. Go to MY CASES.
2. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down).
3. Copy that tracking number here: ______________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says CREATE CORRESPONDENCE in the set of action buttons on the left-hand side of the screen.
6. A new section, called Create Correspondence, appears within the Request Details.
7. Enter the following for the fields:
   a. Correspondence Type: Other
   b. Correspondence Attachments: Select a file from your computer’s directory
8. Press the CREATE button.
9. The correspondence has been successfully added to the Case File.

_After this exercise, you should see a new correspondence item in the case file under the correspondence tab._
Exercise 7.3 – Add a Letter to the Case File

In this exercise, students will add correspondence to the case file without notifying the requester, to account for communications that have occurred outside of the FOIAonline system.

1. Go to MY CASES.
2. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says CREATE CORRESPONDENCE in the set of action buttons on the left-hand side of the screen.
6. A new section, called Create Correspondence, appears within the Request Details.
7. Enter the following for the fields:
   a. Correspondence Type: Correspondence to Requester
   b. Letter Template: Generic Letter
   c. Subject: FOIA Request Clarification
   d. Body: Please clarify the above-referenced request, providing a date range.
   e. Letter: Please clarify the above-referenced request, providing a date range.
      i. Use the “Insert” dropdown menu, as necessary, to place case file-specific information into the text area.
8. Press the CREATE button.
9. The correspondence has been successfully added to the Case File.

After this exercise, you should see a new correspondence item in the case file under the correspondence tab as a PDF.
Module 8 - Record Uploading

Uploading and releasing records is one of the primary functions of FOIAonline (as it’s the goal of FOIA). Users are able to release records while processing (Interim Release) or after all processing has been completed. Marking a record as “releasable” does not immediately release the record to the public.

Record Uploading Training Details

Records can only be uploaded to a request once it is perfected. Responsive records can be uploaded with or without files. When uploading files, multiple files can be selected from a user’s computer using the CTRL or SHIFT keys and clicking various files.

Uploading records without a file upload is done when the record is not readily reproducible electronically. Examples are various forms of media or older records which could be damaged if reproduced.

After uploading responsive records, keywords can be applied to facilitate easier searching. Upon upload the keywords are applied to every record but can be applied individually from the Edit Responsive Record screen.

Records are designated as “releasable” or “unreleasable” via the Release Type. The Release Type is applied to the batch of records being uploaded initially, but can be modified per record after upload.
Exercise 8.1: Upload Record with File

Users assigned to the request, or a task off the request, are able to upload records to the case file.

1. The user has opened a request and is on the Request Details page.
2. Verify the request has been perfected.
3. Click the UPLOAD RESPONSIVE RECORDS action from the left side menu.
4. Press the SELECT FILES button.
5. Access the folder location for the desired file, select the file, and press the OPEN button. (You can also select the file by double clicking.)
6. (Optional) Modify the Record Title.
7. Select the Release Type: UU – Unredacted Unreleasable for the required field.
8. (Optional) Supply keywords for the record.
9. Press the SAVE CHANGES button.
10. (Optional) Remove an uploaded record by clicking the DELETE (Trash) icon then press the YES button to confirm deletion.
11. (Optional) Once the record(s) is/are uploaded, modify the Release Type for individual records from the Case File - Records sub-tab and press the SAVE CHANGES button.

*Note: Once a record has been uploaded to a request it can be found on the Case File - Records sub-tab.
Exercise 8.2: Upload Record without File

Uploading a record without a file allows the user to specify a record title. The record title should be specific enough to allow the requester to identify and find the record.

1. The user has opened a request and is on the Request Details page.
2. Verify the request has been perfected.
3. Click the UPLOAD RESPONSIVE RECORDS action from the left side menu.
4. Press the ADD WITHOUT FILE UPLOAD button.
5. (Optional) Modify the Record Title.
6. Select a Release Type for the required field.
7. (Optional) Supply keywords for the record.
8. Press the SAVE CHANGES button.
9. (Optional) Remove a record by clicking the DELETE (Trash) icon then press the YES button to confirm deletion.
Exercise 8.3: Apply Exemptions to a Record

In order to apply exemptions to a request, there must be a record associated to the request. The record does not need to be released but exemptions are applied through the record. Record release types can also be modified in the Records tab in the Publish column.

1. The user has opened a request and is on the Request Details page.
2. Click the CASE FILE tab.
3. Click the PENCIL icon (✎) under the Action column.
4. Select the appropriate exemptions using the Exemptions Applied checkboxes.
5. (Conditionally Mandatory) If Ex. 3 or Ex. 5 are selected, the user must also select a statute or subtype respectively.
6. Press the SAVE CHANGES button.
Module 9 - Processing: Tasks and Collaboration

Tasks allow collaboration on FOIA responses. While each FOIA request has one and only one owner assignment, each request can have multiple tasks to facilitate collaboration between multiple offices.

Tasks and Collaboration Training Details

- Assignments vs. Tasks
- Task Owner Access to FOIA Request Details

Tasks follow the same assignment constraints as FOIA requests, providing offices control over how they can be tasked by other offices.
Exercise 9.1: Process a Simple Task

Part 1: Create Collaboration Tasks
1. Pair up with another student who will collaborate with you on a FOIA response. Get their name and organization name.
2. Write down the name of your partner:
3. Write down the organization name of your partner:
4. Go to MY CASES.
5. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down).
6. Copy that tracking number here:
7. Provide that tracking number to your partner.
8. Click the FOIA Request TRACKING NUMBER to access the Request Details.
9. Press the button that says CREATE TASK in the set of action buttons on the left-hand side of the screen.
10. A new section, called Task Assignment, appears within the Request Details. Note that this new section contains both the Assign to Organization and Assign to Individuals sections.
11. Press the ADD ORGANIZATION button.
12. A new window opens, titled SELECT ORGANIZATION.
13. Note that the search results contain names of offices that are part of your office (below).
14. Enter your partner’s office name in the NAME field.
15. Press the SEARCH button.
16. Look at the search results shown and select the office belonging to your partner.
17. Press the SELECT button to save your selection.
18. Enter the following fields:
   a. Task Description: Please search for records related to this FOIA request and upload them to the case file.
   b. Task Due Date: Next Friday
   c. Allow task recipients to edit metadata: No
19. Press the CREATE TASK button.
20. Repeat steps 9 through 19 to create a 2nd task to your partner on this case file. Alter the task description and due date.
21. The new tasks have been created and are available to your partner by pressing on their UNASSIGNED CASES dashboard. Note that you will see this task in the Assigned Tasks tab of your FOIA request.
Exercise 9.1: Process a Simple Task

Part 2: Process a Simple Collaboration Task

15. In Part 1, you paired up with another student to collaborate on a FOIA response. They should have sent you a task on a FOIA request, seeking responsive records.

16. Go to UNASSIGNED CASES.

17. Look for the two tasks that have come to your office from your partner with the tracking number provided to you by your partner in Part 1.

18. Write that tracking number here: ______________________________

19. Click the FOIA Request TRACKING NUMBER to access the Task Details for one of the tasks.

20. Browse the Request Details and Press the button that says CLOSE OUT TASK in the set of action buttons on the left-hand side of the screen.

21. Enter the following REQUIRED FIELDS in the Close Out Task section:
   a. Outcome: No Records Found
   b. Comments: There are no records for this request in this office.

22. Click the CLOSE OUT TASK button

Your response to this FOIA request has been captured and stored in the case file. The owner of this FOIA request, your partner, has been notified that your task has been performed.
Exercise 9.2 – Upload a record in response to a task

1. In Exercise 9.1, you paired up with another student to collaborate on a FOIA response. They should have sent you a task on a FOIA request, seeking responsive records.

2. Go to UNASSIGNED CASES

3. Look for the 2nd of two tasks that have come to your office from your partner with the tracking number provided to you by your partner in Exercise 9.1.

4. Write that tracking number here: ______________________________

5. Click the FOIA Request TRACKING NUMBER to access the Task Details

6. Press the button that says UPLOAD RESPONSIVE RECORDS in the set of action buttons on the left-hand side of the screen

7. In the Upload Responsive Records section, click the SELECT FILES button

8. Choose at least one (1) file from your computer’s directory

9. Click the SAVE CHANGES button

10. Press the button that says CLOSE OUT TASK in the set of action buttons on the left-hand side of the screen

11. Enter the following fields in the Close Out Task section:
   a. Outcome: Records Uploaded
   b. Comments: The requested records have been uploaded to the case file.

12. Click the CLOSE OUT TASK button
Module 10 - Fee Waiver & Expedited Processing

In coordination with a request, requesters are able to submit requests for special processing. Within FOIAonline these requests for special processing are handled in parallel with the request itself.

Fee Waiver & Expedited Processing Training Details

FOIAonline generates specific Fee Waiver and Expedited Processing tasks, which are sent to the same organization as the request is submitted. These tasks are separate from the request but their determination populates within the request and they can be tracked from the request’s Assigned Tasks tab. Each task can be assigned throughout the agency to the individual who is responsible for making the determination.
Exercise 10.1: Fee Waiver Processing

Fee Waivers are to be processed according to each agency’s FOIA regulations. The instructions below describe the system actions required to process a Fee Waiver.

1. Access a Fee Waiver task from the dashboard.
2. Click the EDIT OR CLOSE OUT TASK action from the left side menu.
3. Enter the Adjudication Date
4. Enter the Closed Date.
5. Assess the details provided in the Original Justification field.
6. Select the appropriate value from the Decision dropdown.
7. Press the CLOSE OUT TASK button.

Notes:

- If Deny is selected then the mandatory Denial Reason must be populated.
- If the user is unsure of a decision, they can press the Save button to retain all modified information. Saving the task does not close the task, nor apply the decision for reporting.

Upon fee waiver task closure, the requester receives an email notification with the decision if he or she has an email address on file.
Exercise 10.2: Expedited Processing

Expedited Processing determinations are to be processed according to each agency’s FOIA regulations. The instructions below describe the system actions required to process an Expedited Processing task.

1. Access an Expedited Processing task from the dashboard.
2. Click the EDIT OR CLOSE OUT TASK action from the left side menu.
3. Enter the Closed Date.
4. Assess the details provided in the Original Justification field.
5. Select the appropriate value from the Decision dropdown.
6. Press the CLOSE OUT TASK button.

Notes:
- If Deny is selected then the mandatory Denial Reason must be populated.
- If the user is unsure of a decision, they can press the Save button to retain all modified information. Saving the task does not close the task, nor apply the decision for reporting.

Upon expedited processing task closure, the requester receives an email notification with the decision if he or she has an email address on file.
When FOIA staff members need to estimate costs and notify the requester of these cost estimates, the Estimate Cost feature tracks the estimate and the correspondence to the requester, depositing it in the case file.

Further, this feature updates the status of the request, changing it to Estimate Costs.

### Estimation Training Details

- Overview of the Estimate Costs action
- Processing the Estimate Costs Notice
- Other Actions Following the Estimate
Exercise 11.1 – Estimate Costs and Send Estimate

Fee estimates are allowed at any time on a FOIA Request to notify the requester of an agency’s expectation for processing costs.

1. Go to MY CASES.
2. Choose the FOIA Request that you used during the “Assign to Individual” exercise, 5.1 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Press the button that says ESTIMATE COSTS in the set of action buttons on the left-hand side of the screen.
6. A new section, called Estimate Costs, appears within the Request Details.
7. Enter values in as many estimate fields as desired.
8. Press the TOTAL button. Note that the Total Estimate is calculated, which includes any fee category discounts.
9. Press the SAVE CHANGES button.
10. (Optional) Press the OK button in the notification of fee limit exceeded popup.
11. The estimates have been successfully saved. Note that a new task, called Estimate Cost Notice, has been created.
12. Note that the Status of the request has changed to Estimate Costs
13. Find the Notice that will be sent to the Requester by clicking on the ASSIGNED TASKS tab
14. Click on the PENDING task assigned to you. Note that, if you expand the details by clicking the arrow ( ), you will see that the description for this pending task is Estimate Cost Notice.
15. Press the button that says CLOSE OUT TASK in the set of action buttons on the left-hand side of the screen.
16. In the Estimate Cost Notice section, revise the *SUBJECT and *BODY.
17. Select either YES or NO from the MARK ESTIMATE AS REQUIRED FIELD.
18. Click on the SEND button to send this estimate to the requester.
19. An email with the fee estimate has been sent.

Once the fee estimate has been sent, an agency can make the decision to stop the clock, if appropriate, using the STOP THE CLOCK button in the set of action buttons on the left-hand side of the screen.
Module 12 - Capturing and Billing Costs

Accurate time keeping within FOIAonline contributes to streamlined requester invoicing and Annual Report creation.

Capturing and Billing Costs Training Details

Costs are always added through the Admin Cost tab. This tab facilitates the addition of time for the current user, other system users, or non-system users. If an entry is provided in error then the user who created the entry is able to remove it. Users who have access to the request, or tasks off the request, have the ability to provide Admin Cost entries.

Inside This Training

12-1 Exercise 12. 1 – Create Billable Admin Cost for Self

12-2 Exercise 12. 2 – Create Unbillable Admin Cost for Self

12-3 Exercise 12. 3 – Create Billable Admin Cost for Other User

12-4 Exercise 12. 4 – Create Billable Admin Cost for Non-system User

Time and expenses listed in the Admin Cost tab feed directly to expense metrics within the Annual Report.
Exercise 12.1: Create Billable Admin Cost for Self

Most users will only enter time spent on a request for them.

1. The user has opened a request and is on the Request Details page.
2. Click the ADMIN COST tab.
3. Press the ADD NEW ENTRY button.
4. Verify the currently logged in user’s name appears in the User Name field.
5. Select the appropriate Charge Date.
6. Select the appropriate Charge Type from the dropdown.
7. Enter the number of hours (Search or Review), Expense amount (Mailing or Other), or Number of Copies (Copy).
8. Select YES from the Billable? dropdown.
9. Press the SAVE CHANGES button.
10. Note that the Invoice Amount displays, which deducts any applicable fee category discounts from the total billable admin entries.

At a minimum, a user may add time in 15 minute increments (0.25).

The discounts allotted for Media/Educational and Other fee categories are automatically deducted from the invoice.
Exercise 12.2: Create Unbillable Admin Cost for Self

Sometimes agency FOIA staff have processing responsibilities which cannot be charged to a requester but require a portion of their time.

1. The user has opened a request and is on the Request Details page.
2. Click the ADMIN COST tab.
3. Press the ADD NEW ENTRY button.
4. Verify the currently logged in user’s name appears in the User Name field.
5. Select the appropriate Charge Date.
6. Select the appropriate Charge Type from the dropdown.
7. Enter the number of hours (Search or Review), Expense amount (Mailing or Other), or Number of Copies (Copy).
8. Select NO from the Billable? dropdown.
9. Enter the Charge Description.
10. Press the SAVE CHANGES button.

Any charges marked as not billable will be omitted from the Invoice. These charges are agency expenses which are not reimbursable.
Exercise 12.3: Create Billable Admin Cost for Other Agency User

FOIAonline allows agency users to enter costs for other agency users if there are additional charges which need to be recorded.

1. The user has opened a request and is on the Request Details page.
2. Click the ADMIN COST tab.
3. Press the ADD NEW ENTRY button.
4. Click the User Name field or person icon (`.`).
5. Enter the Name, Organization Acronym, or Organization Name of the user and press the Search button.
6. Click the radio icon next to the desired individual. Press the Select button.
7. Select the appropriate Charge Date.
8. Select the appropriate Charge Type from the dropdown.
9. Enter the number of hours (Search or Review), Expense amount (Mailing or Other), or Number of Copies (Copy).
10. Select YES from the Billable? dropdown.
11. Press the SAVE CHANGES button.
12. Note that the Invoice Amount displays, which deducts any applicable fee category discounts from the total billable admin entries.

If a user neglected to input their time, a second system user can input that time on their behalf.
Exercise 12.4: Create Billable Admin Cost for Non-system User

Occasionally non-system users will perform functions outside the system which must be tracked within the system to facilitate accurate expense reporting.

1. The user has opened a request and is on the Request Details page.
2. Click the ADMIN COST tab.
3. Press the ADD NEW ENTRY button.
4. Select NON-SYSTEM USER from the User Type dropdown.
5. Enter the user’s name in the NON-SYSTEM USER field.
6. Enter the user’s LOADED RATE.
7. Enter the user’s BILLING RATE.
8. Select the appropriate Charge Date.
9. Select the appropriate Charge Type from the dropdown.
10. Enter the number of hours (Search or Review), Expense amount (Mailing or Other), or Number of Copies (Copy).
11. Select YES from the Billable? dropdown.
12. Press the SAVE CHANGES button.
13. Note that the Invoice Amount displays, which deducts any applicable fee category discounts from the total billable admin entries.
Module 13 - Case File Reviews

Reviewers are set individually on a case by case basis. FOIA staff, their managers, or any other person who participates in a FOIA response can add a reviewer to the case file’s review list. There are several rules in place requiring reviews and prohibiting the removal of reviewers in order to ensure the appropriate release of information to the public.

Case File Review Training Details

- Understanding how and when reviews occur
- Refresher on processing tasks
- Rules on reviews
  - Adding/removing reviewers
  - Agency-specific minimums for reviewers
  - Kicking off reviews

---

Case file reviews begin automatically once a FOIA request has a disposition set.
Exercise 13.1: Adding Reviewers

In this exercise, students will learn how to add reviewers, in the order they choose, to a case file.

1. Go to MY CASES.
2. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Click on the Review tab on the Request Details screen.
6. A new section, called Assigned Reviewers, appears within the Request Details.
7. Press the ADD REVIEWER button.
8. A new window opens, titled SELECT INDIVIDUAL.
9. Enter your partner’s name in the NAME field.
10. Press the SEARCH button.
11. Look at the search results shown and select the name of your partner.
12. Enter your partner’s student name here: _____________________
13. Press the SELECT button to finalize your selection.
14. Note the individual’s name added to the Assigned Reviewers table.
15. Note the Review Order can be rearranged by clicking on the blue up and down arrows found in the Change Review Order column.
16. (Optional) Repeat steps 7-13 as many times as necessary, to meet your agency’s minimum reviewer requirement.

The FOIA request now has an assigned reviewer who will receive a task once the close-out process has begun.

All reviewers listed on a case file must complete their review (in the order shown) before a case can be closed. FOIA staff should not add any optional reviewers – all are mandatory.
Module 14 - Close-Out

There are multiple steps involved in closing out a FOIA request. FOIA staff can use the Close-Out process to control what information is sent to the requester and when.

There are also several prerequisites for closing out a case, including conducting a case file review, setting the disposition and, depending on the case, marking at least one (1) record for public release.

Close-Out Training Details

- 3-Step Close Out process
  - 1. Set Disposition (Begin Close-Out)
  - 2. Conduct Case File Review (Reviewers)
  - 3. Send Disposition Notice (Final Disposition Notice Task)

- Rules for Closing Out with Dispositions
- Best Practices for Using the “Other, Other” Disposition

You should only begin the Close-Out process when you are ready to complete the review and notify the requester.

The only way to stop the process is to reject a review, if a review is required.
Exercise 14.1: Close Out with Records Released

In this exercise, students will learn how to begin the close-out process, meet all of the prerequisites for closure and set the appropriate disposition. For this exercise, closure will come with at least one (1) record released to the public.

1. Go to MY CASES.
2. Choose the FOIA Request that you assigned to yourself in Exercise 5.1 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Note that, in exercise 9.2, your partner was asked to upload at least one (1) record into this case file. If that did not occur, Press the UPLOAD RESPONSIVE RECORDS button on the left-hand side of your screen and upload a responsive record. See exercise 9.2 for a reminder of the steps necessary to upload a responsive record. If your partner already uploaded a record, skip to the next step.
6. A new section, called Final Disposition, appears within the Request Details. Note that this new section contains sub-sections for Final Disposition, Responsive Records, Exemptions Used, and Invoice Comments/Instructions.
7. Select the following for Disposition: Full Grant
8. (Optional) select a Letter Template and modify the letter.
9. Select the appropriate value from the PUBLISH dropdown.
10. Press the BEGIN CLOSE OUT button.
11. You will be prompted “Are you sure you want to begin the close out process? Once the close out process has started, it cannot be undone.” Press the YES button.
12. Verify that your partner has the tracking number for this request and let them know that they should go to MY CASES and look for that tracking number. Once they open that task, they should Close Out the task with an Approval.

Did you know?
There is more than one way to publish a record.
1. Select either “UR” or “RR” from the Publish dropdown menu
2. Select either “UR” or “RR” from the case file’s Publish dropdown menu
3. Edit the record using the edit icon and change the Release Type dropdown menu to either “UR” or “RR”
13. Go to MY CASES.

14. Click on the FOIA Request TRACKING NUMBER to access the Final Disposition Notice task.

15. A new section, called Final Disposition Notice, appears within the Task Details. Edit the Subject and Body and select any case file items to be attached to the email.

16. Press the SEND button.

*The case has been closed and the response has been sent to the requester.*
Exercise 14.2: Close Out with Exemptions Applied

In this exercise, students will learn how to begin the close-out process, meet all of the prerequisites for closure and set the appropriate disposition. For this exercise, closure will come with at least one (1) record released to the public with exemptions applied to that record.

1. Go to ASSIGNED CASES.
2. Choose the FOIA Request that you assigned to someone other than yourself in Exercise 5.2 (use the tracking number that you wrote down).
3. Copy that tracking number here: __________________________
4. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
5. Assign the FOIA request to yourself. See Exercise 5.1 for a reminder of the steps necessary to assign to yourself.
6. Go to MY CASES.
7. Click on the FOIA Request TRACKING NUMBER to access the Request Details.
8. Add your partner as a case file reviewer. See Exercise 13.1 for a reminder of the steps necessary to add a reviewer to a FOIA request.
9. Upload a responsive record. See Exercise 9.2 for a reminder of the steps necessary to upload a responsive record.
10. Edit the information about the record you uploaded by clicking on the edit icon in the Action column.
11. A new section, called Edit Responsive Record, appears within the Request Details.
12. Check one or more EXEMPTIONS APPLIED.
13. Press the SAVE RECORD CHANGES button. Note that the record has been saved successfully.
14. Press the BEGIN CLOSE-OUT PROCESS button on the left-hand side of your screen.

15. A new section, called Final Disposition, appears within the Request Details. Note that this new section contains sub-sections for Final Disposition, Responsive Records, Exemptions Used, and Invoice Comments/Instructions.

16. Enter the following Information for Disposition: Partial Grant/Partial Denial

17. Select the appropriate value from the PUBLISH column drop down in the Responsive Records section next to each record.

18. Press the BEGIN CLOSEOUT button.

19. You will be prompted “Are you sure you want to begin the close out process? Once the close out process has started, it cannot be undone.” Press the YES button.

20. Verify that your partner has the tracking number for this request and let them know that they should go to MY CASES and look for that tracking number. Once they open that task, they should Close Out the task with an Approval.

21. Go to MY CASES.

22. Click on the FOIA Request TRACKING NUMBER to access the Final Disposition Notice task.

23. A new section, called Final Disposition Notice, appears within the Task Details. Edit the Subject and Body and select any case file items to be attached to the email.

24. Press the SEND button.

_The case has been closed and the response has been sent to the requester._
Module 15 - Clock Management

There are a few scenarios that require the clock to be stopped, such as fee related reasons, clarification, or the request was originally received before it was entered into the system. This module describes how to manage the clock throughout the life cycle of a request.

Clock Management Training Details

This section includes the functionality to:

- Stop the Clock
- Start the Clock
Exercise 15.1: Stop the Clock

Users are allowed to stop the clock for clarification or fee-related reasons. These stoppages are only allowed when additional processing is dependent on a requester’s further action.

1. The user has opened a request and is on the Request Details page.
2. Verify the request has been perfected.
3. Click the STOP THE CLOCK action from the left side menu.
4. Select a value from the REASON dropdown.
5. Enter text into the NOTES field.
6. Press the STOP THE CLOCK button.
7. Note the (ON HOLD) text that displays next to the clock icon.
Exercise 15.2: Start the Clock

After the requester has provided the necessary materials to continue processing the request the agency user must start the clock.

1. The user has opened a request and is on the Request Details page.
2. Verify the request clock is stopped. *Note: The text “(On Hold)” appears at the upper right of the Request Details page.
3. Click the START THE CLOCK action from the left side menu.
4. Press the START THE CLOCK button.
5. Note the (ON HOLD) text next to the clock icon has been removed.
Due Date Management

Module 16 - Due Date Management

This module describes miscellaneous system activities which are likely to happen infrequently but are necessary for users who use FOIAonline frequently.

Due Date Management Training Details

This section includes the functionality to:

- Extend the request due date
- Extend a task due date
Exercise 16.1: Extend Request Due Date

Due date extensions are frequently used to provide the requester with a realistic expectation of processing time given current agency backlogs and relative difficulty of the request.

1. The user has opened a request and is on the Request Details page.
2. Click the EXTEND DUE DATE action from the left side menu.
3. Select a value from the Unusual Circumstances dropdown.
4. (Conditionally Required) Select YES from the Requester Extension Approval dropdown.
5. (Conditionally Required) Enter an appropriate date into the Date Requester Extension Approval Granted field. *Note: The date must be after the submitted date and prior to the current date.
6. Enter text into the EXTENSION JUSTIFICATION field.
7. Press the EXTEND DUE DATE button.

If a clock stoppage has previously existed on the request then the due date can be extended without approval. Otherwise approval is required.

Task due dates can be extended by any user who has edit access to the request.

If an extension is due to unusual circumstances the system will not count the request as backlogged until the clock reaches 30 days.
Exercise 16.2: Extend Task Due Date

If a request is put on hold or the due date is extended the due date of any related tasks is not altered automatically. If the clock stoppage or due date extension necessitates a change in existing tasks then those can be modified from the Assigned Tasks tab.

1. The user has opened a request and is on the Request Details page.
2. Click the ASSIGNED TASKS tab.
3. Click the DUE DATE field or calendar (📅) icon.
4. Select the desired date.
5. Press the SAVE CHANGES button.
Module 17 - Interim Release

An Interim Release allows a subset of the records to be released while the request itself is still being processed. This module describes how to process an Interim Release.

Interim Release Training Details

Over the course of processing the request it may become obvious that some records will be available sooner than others. In these instances, the agency user and requester can agree to release records as they are available. This process is called an Interim Release, or “rolling release.”
An Interim Release allows a subset of the records to be released while the request itself is still being processed.

1. The user has opened a request and is on the Request Details page. Records have been uploaded to the request. A reviewer has been added to the request.
2. Click the INTERIM RELEASE action from the left side menu.
3. Select either “UR,” “RR,” or “REQ” from the Publish column’s dropdown menu.
4. (Optional) Apply exemptions to a record. See Exercise 8-3.
5. Press the SAVE CHANGES button.

The Interim Release functionality is frequently used when one record is being held up in the Consultation process.
Consultations and referrals are required when a record that is discovered during processing is related to another agency or belongs with another agency.

When a referral is received from a non-system participating agency, the referral can be manually entered into FOIAonline for complete tracking and reporting measures. Records can also be sent to system participating agencies via referrals from within FOIAonline.

The same is true for consultations. Consultations received offline can be manually entered into FOIAonline, and consultations can also be created for participating agencies from within the system.

This section includes:

- How to create a Referral
- How to create a Consultation
Exercise 18.1: Referral Creation

Referrals created to partner agencies will be transmitted within the system but referrals received from other agencies must be input.

1. The user is on the Home tab.

2. Click the NEW REFERRAL action from the left side menu.

3. Make a selection or enter text from the following required fields:
   a. Agency
   b. Sub-Agency
   c. Submitted Date
   d. First Name
   e. Last Name
   f. Mailing Address Location
   g. Address Line 1
   h. City
   i. State/Province
   j. Zip Code/Postal Code
   k. Will Pay Up To
   l. Description

4. Enter optional information as necessary.

5. (Recommended) Press the SELECT FILES button.

6. (Recommended) Select a file from the user’s computer.

7. (Recommended) Press the OPEN button.

8. Press the SUBMIT button.
Exercise 18.2: Consultation Creation and Closure

Consultations received outside the system must be input into FOIAonline in order to capture them in the Annual Report.

Consultation Creation
1. The user is on the HOME tab.
2. Click the NEW CONSULTATION action from the left side menu.
3. Make a selection or enter text from the following required fields:
   a. Agency
   b. Sub-Agency
   c. Received From
   d. Original Request Date
   e. Submitted Date
   f. Due Date
   g. Description
   h. Comments
4. (Optional) Press the SELECT FILES button.
5. (Optional) Select a file(s) from the user’s computer.
6. (Optional) Press the OPEN button.
7. Press the CREATE button.

Consultation Closure
1. The user has opened a consultation and is on the Consultation Details page.
2. Click the Begin Close Out Process action from the left side menu.
3. Enter text in the AGENCY OPINION field.
4. Press the BEGIN CLOSE OUT button.
5. You will be prompted “Are you sure you want to begin the consultation close out process? Once the close out process has started it cannot be undone.” Press the YES button.

Note: Minimum number of reviewer requirements are also exist for consultations.
Module 19 - Logging Payments

Payments made by requesters offline can be entered by Agency Users as they are received. These payments are logged as manual payments and can be modified at any time using the edit payment and delete payment functionalities.

Logging Payments Training Details

When a requester sends in an invoice payment, the amount can be denoted on the case file. Requesters who have not paid in 30 days display in the Delinquency Report until the total invoice amount is reconciled.

This section includes:
- How to log a payment
Exercise 19.1: How to Log a Payment

Referrals created to partner agencies will be transmitted within the system but referrals received from other agencies must be input.

1. Go to MY CASES
2. Click on the FOIA Request TRACKING NUMBER to access the Request Details
3. Click on the Case File Tab
4. Click on the Financing Tab
5. Click on the ADD PAYMENT button
6. Enter the following required fields:
   a. Amount Paid
   b. Date Paid
7. Click the Save Changes button
8. Note the new payment can be found in the Payments table.

All payments entered by agency users will be logged as a Manual payment type.

The payment can be modified or deleted at any time.